This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.
IMPORTANT

READ ALL INSTRUCTIONS carefully and completely before using the receiver.

SAVE THIS INSTRUCTION MANUAL — This instruction manual contains important operating instructions for the IC-PCR100 COMMUNICATIONS RECEIVER FOR COMPUTER.

USE antenna(s), such as a well-matched 50 Ω antenna and feedline. For radio communications, the antenna is of critical importance, along with sensitivity.

SYSTEM REQUIREMENTS

• IBM PC/AT compatible computer
• An RS-232C serial port (38400 bps or faster)
• Microsoft® Windows® 95 or Microsoft® Windows® 98
• Intel i486DX4 processor or faster (Pentium® 100 MHz or faster recommended)
• At least 16 MB RAM
• At least 10 MB of hard disk space
• At least 640 × 480 pixel display (800 × 600 pixel display recommended)

OPERATING THEORY

Electromagnetic radiation which has frequencies of 20,000 Hz (20 kHz*) and above is called radio frequency (RF) energy because it is useful in radio transmissions. The IC-PCR100 receives RF energy from 0.5 MHz* to 1300 MHz and converts it into audio frequency (AF) energy which in turn actuates a loudspeaker to create sound waves. AF energy is in the range of 20 to 20,000 Hz.

*kHz is an abbreviation of kilohertz or 1000 hertz, MHz is abbreviation of megahertz or 1,000,000 hertz, where hertz is a unit of frequency.

OPERATING NOTES

The IC-PCR100 may receive its own oscillated frequency, resulting in no reception or only noise reception, on some frequencies.

The IC-PCR100 may receive interference from extremely strong signals on different frequencies or when using an external high-gain antenna.

Versions of the IC-PCR100 which display “CE” on the serial number seal, comply with the essential requirements of the 89/336/EEC directive for Electromagnetic Compatibility.
CAUTIONS

⚠️ WARNING! NEVER connect the receiver to an AC outlet. This may pose a fire hazard or result in an electric shock.

NEVER connect other than the specified AC adapter to the receiver. This connection will ruin the receiver.

NEVER connect the receiver to a power source of more than 16 V DC such as a 24 V battery. This connection will ruin the receiver.

NEVER expose the receiver to rain, snow or any liquids.

DO NOT use or place the receiver in areas with temperatures below 0°C (+32°F) or above +50°C (+122°F) or, in areas subject to direct sunlight.

AVOID placing the receiver in excessively dusty environments.

AVOID the use of chemical agents such as benzine or alcohol when cleaning, as they damage the receiver surfaces.

Place unit in a secure place to avoid inadvertent use by children.

For U.S.A. only (FCC information)

CAUTION: Changes or modifications not expressly approved by Icom Inc. could void the user’s authority to operate this receiver.

Class B digital device users

This equipment has been tested and found to comply with the limits for Class B digital devices, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

For Canada only

Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMPORTANT</td>
<td>i</td>
</tr>
<tr>
<td>SYSTEM REQUIREMENTS</td>
<td>i</td>
</tr>
<tr>
<td>OPERATING THEORY</td>
<td>i</td>
</tr>
<tr>
<td>OPERATING NOTES</td>
<td>i</td>
</tr>
<tr>
<td>CAUTIONS</td>
<td>ii</td>
</tr>
<tr>
<td>TABLE OF CONTENTS</td>
<td>iii</td>
</tr>
<tr>
<td>1 INSTALLATION</td>
<td>1-5</td>
</tr>
<tr>
<td>■Hardware installation</td>
<td>1</td>
</tr>
<tr>
<td>■Antenna installation</td>
<td>2</td>
</tr>
<tr>
<td>■Grounding</td>
<td>2</td>
</tr>
<tr>
<td>■AF output level selection</td>
<td>3</td>
</tr>
<tr>
<td>■Software installation</td>
<td>4</td>
</tr>
<tr>
<td>■RS-232C port setting</td>
<td>5</td>
</tr>
<tr>
<td>■Mouse property setting</td>
<td>5</td>
</tr>
<tr>
<td>2 PANEL DESCRIPTION</td>
<td>6-15</td>
</tr>
<tr>
<td>■Multi-function receiver screen</td>
<td>6</td>
</tr>
<tr>
<td>■Function display</td>
<td>10</td>
</tr>
<tr>
<td>■Simple function receiver screen</td>
<td>12</td>
</tr>
<tr>
<td>■Function controller screen</td>
<td>14</td>
</tr>
<tr>
<td>■Simple function receiver sub screens</td>
<td>15</td>
</tr>
<tr>
<td>3 BASIC OPERATION</td>
<td>16-21</td>
</tr>
<tr>
<td>■Receiving</td>
<td>16</td>
</tr>
<tr>
<td>■Setting a frequency</td>
<td>17</td>
</tr>
<tr>
<td>■Setting a tuning step</td>
<td>18</td>
</tr>
<tr>
<td>■Receive mode selection</td>
<td>18</td>
</tr>
<tr>
<td>■Automatic mode selection</td>
<td>19</td>
</tr>
<tr>
<td>■Setting squelch level</td>
<td>20</td>
</tr>
<tr>
<td>■IF filter selection</td>
<td>20</td>
</tr>
<tr>
<td>■Attenuator function</td>
<td>21</td>
</tr>
<tr>
<td>■Automatic noise limiter</td>
<td>21</td>
</tr>
<tr>
<td>4 MEMORY CHANNELS</td>
<td>22-25</td>
</tr>
<tr>
<td>■General</td>
<td>22</td>
</tr>
<tr>
<td>■Saving memory channels</td>
<td>22</td>
</tr>
<tr>
<td>■Selecting a memory channel</td>
<td>23</td>
</tr>
<tr>
<td>■Memory channel programming</td>
<td>24</td>
</tr>
<tr>
<td>■Clearing a memory channel</td>
<td>24</td>
</tr>
<tr>
<td>■Editing the memory list</td>
<td>25</td>
</tr>
<tr>
<td>5 SCAN OPERATION</td>
<td>26-33</td>
</tr>
<tr>
<td>■Scan types</td>
<td>26</td>
</tr>
<tr>
<td>■Programmed scan</td>
<td>27</td>
</tr>
<tr>
<td>■Setting scan edges</td>
<td>28</td>
</tr>
<tr>
<td>■Auto memory write scan</td>
<td>29</td>
</tr>
<tr>
<td>■Memory scan</td>
<td>30</td>
</tr>
<tr>
<td>■Versatile memory scan</td>
<td>31</td>
</tr>
<tr>
<td>■Scan resume condition</td>
<td>32</td>
</tr>
<tr>
<td>■Scan speed setting</td>
<td>33</td>
</tr>
<tr>
<td>6 BAND SCOPE</td>
<td>34-35</td>
</tr>
<tr>
<td>■Operation</td>
<td>34</td>
</tr>
<tr>
<td>■Changing the automatic sweep step limit</td>
<td>35</td>
</tr>
<tr>
<td>7 TONE SQUELCH OPERATION</td>
<td>36</td>
</tr>
<tr>
<td>8 TROUBLESHOOTING</td>
<td>37</td>
</tr>
<tr>
<td>9 SPECIFICATIONS AND SUPPLIED ACCESSORIES</td>
<td>38-39</td>
</tr>
<tr>
<td>■Specifications</td>
<td>38</td>
</tr>
<tr>
<td>■Supplied accessories</td>
<td>39</td>
</tr>
</tbody>
</table>
Hardware installation

Refer to the diagram below for connections.
Antenna installation

Antennas play a very important role in receiver operation. Connecting a poor quality antenna to the IC-PCR100 will result in less than optimum performance.

Select antenna(s), such as a well-matched 50 Ω antenna and feedline. 1.5:1 of Voltage Standing Wave Ratio (VSWR) is recommended for a desired band. Of course, the antenna line should be a coaxial cable.

**CAUTION:** Protect your receiver from lightning by using a lightning arrester.

**NOTE:** The supplied antenna is a simple plain antenna which may not obtain indicated specifications. To obtain maximum performance from the IC-PCR100, you must purchase an external wide band antenna such as an optional Icom AH-7000 (25–1300 MHz), etc.

Contact your nearest Icom Dealer or Service Center for regarding optimum antenna locations.

The antenna connector type is BNC, so an adapter may be necessary to connect an optional antenna.

Grounding

**WARNING:** NEVER use a gas pipe or electrical conduit pipe for grounding.

To prevent accidents involving electricity and interference from computers, ground the receiver through the GROUND terminal on the rear panel.

For best results, connect a heavy gauge cable to a water pipe or long, earth-sunk copper rod. Make the distance between the [GND] terminal and ground as short as possible.
AF output level selection

The received audio can be input into your computer via the sound card.

Before inputting the received audio into the [LINE IN] connector (connector name depends on your sound card), the output level of the [EXT-SP] must be set properly. Perform as follows:

**CAUTION:** Setting ‘STEREO’ and connecting a 2-conductor plug cause a short-circuit. This may damage the audio power amplifier.

**Multi-function receiver screen**

1. Select ‘EXT-Speaker’ in the option menu to bring up the [EXT-Speaker Setting] dialog box.
2. Select the plug type as shown below.
   - “STEREO” for 3-conductor stereo plug.
   - “MONO” for 2-conductor monaural plug.
3. Select the output level as shown at right.
   - “SP” for internal or external speaker.
   - “LINE” for PC sound card or headphones.

**Simple function receiver screen**

1. Right-click* the frequency indication to display shortcut menu and select ‘EXT-Speaker’ in the Option menu to bring up the [EXT-Speaker Setting] dialog box.
   * When the mouse property is set for right-handed.
2. Select the plug type.
   - “STEREO” for 3-conductor stereo plug.
   - “MONO” for 2-conductor monaural plug.
3. Select the output level.
   - “SP” for internal or external speaker.
   - “LINE” for PC sound card or headphones.
4. Connect an appropriate cable between IC-PCR100 and PC.
   - Use a 3-conductor stereo plug for connecting to the receiver.

Connect an appropriate cable between IC-PCR100 and PC.

![Diagram showing connection between IC-PCR100 and PC.](image)
1 INSTALLATION

Software installation

NOTE: Before using the program, make a backup copy of the original disk. After making a backup copy, keep the original disk in a safe place.

NOTE: Depending on the Windows® system files, the PC may require rebooting. In this case, repeat the installation from the beginning.

Installation

1. Boot up Windows.
   • Quit all applications when windows is running.
2. Insert the backup disk 1 into the appropriate floppy drive.
3. Select ‘Run’ from the [Start] menu.
4. Type the setup program name with full path name, then press the [Enter] key. (A:\SETUP [Enter])
5. Following dialog appears. Follow the prompts.

   Program group ‘IC-PCR100’ appears in the ‘Programs’ folder of the [Start] menu.

Software update information

Software update information will be available at the Icom America home page:

http://www.icomamerica.com/
RS-232C port setting

‘COM Port Error’ or ‘Communication failed’ dialog box appears when the RS-232C serial port is not set correctly.

**NOTE:** When launching the program for the first time, this setting dialog appears for setting the RS-232C serial port.

**Multi-function receiver screen**

1. Before launching the program, make sure the IC-PCR100 interface unit is connected correctly.
2. Launch the IC-PCR100 software.
3. Click the [POWER] button in the tool bar or select ‘Power OFF’ in the File menu to temporarily pause the program.
4. Click the [PORT] button or select ‘COM Port’ in the Option menu to bring up the [COM Port Setting] dialog box.
5. Click the desired COM port number to choose it.
6. Click the [OK] button.

**Simple function receiver screen**

1. Before launching the program, make sure the IC-PCR100 interface unit is connected correctly.
2. Launch the IC-PCR100 software.
3. Click the [POWER] button to temporarily pause the program.
4. Right-click* the frequency indication to display shortcut menu and select ‘COM Port’ in the Option menu to bring up the [COM Port Setting] dialog box.
   * When the mouse property is set for right-handed.
5. Click the desired COM port number to choose it.
6. Click the [OK] button.

**Mouse property setting**

The IC-PCR100 uses left and right buttons to rotate a control knob on the multi-function receiver screen or to call up the shortcut menu from the simple function receiver screen. Depending on the mouse property setting of the control panel, main and sub mouse button functions are alternated.

**Setting the button configuration**

1. Select ‘Settings’ from the [Start] menu and click ‘Control Panel.’
2. Open the mouse control panel.
3. Select the button configuration to right- or left-handed.
4. Click [OK] to set and exit the control panel.
**PANEL DESCRIPTION**

### Multi-function receiver screen

1. **POWER BUTTON [POWER]**
   Toggles the receiver power ON and OFF.

2. **FILE MENU [File]**
   Used for turning the software on/off, saving memory channel contents or quitting the program, etc.

3. **VIEW MENU [View]**
   Used for showing/hiding the memory list screen/tool bar or selecting the simple function receiver screen.

4. **SIMPLE FUNCTION RECEIVER BUTTON**
   Push to select the simple function receiver screen.

5. **BANK MENU [BANK]**
   Used for selecting the memory bank.

6. **MEMORY LIST SCREEN BUTTON**
   Push to display or to hide the memory list screen.

7. **EXTERNAL SPEAKER SETTING BUTTON** (p. 3)
   Push to display the external speaker setting dialog box.

8. **OPTION MENU [Option]**
   Used for displaying the external speaker setting dialog box or COM port setting dialog box.

9. **COM PORT SETTING BUTTON** (p. 5)
   Push to display the COM port setting dialog box.

10. **EXIT BUTTON**
    Push to quit and exit this software.
**CLOSE BUTTON**
Push to quit and exit this software.

**ATTENUATOR BUTTON [ATT]** (p. 21)
Push to turn the 20 dB attenuator on and off.

**VOLUME CONTROL [VOLUME]** (p. 16)
Adjusts the audio output.
- Right-click* to increase the volume level; left-click* to decrease the volume level.

**AUTOMATIC NOISE LIMITER BUTTON [ANL]** (p. 21)
Push to turn the automatic noise limiter for receiving AM signals on and off.

**SQUELCH CONTROL [SQUELCH]** (p. 20)
Adjusts the squelch threshold level. The squelch removes noise output from the speaker (closed condition) when no signal is received.
- Right-click* to increase the squelch level; left-click* to decrease the squelch level.

**TONE SQUELCH BUTTON [T-SQL]** (p. 36)
Push to show or hide the [TONE SQUELCH] dialog box for setting tone squelch frequencies.

**RECEIVE MODE BUTTONS [FM], [WFM], [AM], [AUT-M]**
(pg. 18, 19)
Select a receive mode. The [AUT-M] button, automatic mode, selects a previously programmed receive mode automatically depending on a receive frequency.

**SCAN SPEED CONTROL [SPEED]** (p. 33)
Sets the speed at which scans search through frequencies/memories for signals.
- Right-click* to increase the speed; left-click* to decrease the speed.

**SCAN DELAY TIME CONTROL [DELAY]** (p. 32)
Sets the period in which a scan pauses after receiving a signal.
- Right-click* to increase the period; left-click* to decrease the period.

**TUNING STEP UP/DOWN BUTTONS [TS ▲]/[TS ▼]**
(p. 18)
Push to select the tuning steps.

**TUNING DIAL** (p. 17)
Push to set the receive frequency with the selected tuning step.
- Right-click* to increase the frequency; left-click* to decrease the frequency.

**MEMORY BANK UP/DOWN BUTTONS [BANK ▲]/[BANK ▼]** (p. 23)
Push to select the memory bank.

**MEMORY CHANNEL UP/DOWN BUTTONS [CH ▲]/[CH ▼]** (p. 23)
Push to select the memory channel.

* When the mouse property is set for right-handed.
2 PANEL DESCRIPTION

2 KEYPAD [0]–[9], [•], [CE] (p. 17)
   ➤ [0] to [9] are used to input a receive frequency or memory channel directly.
   ➤ [•] (Decimal) button is used to set the MHz digit when inputting a frequency.
   ➤ [CE] (Clear) button is used to clear mistakes while inputting a receive frequency or memory channel.

3 IF FILTER BUTTONS [NAR]/[WID] (p. 20)
   Push to change the IF filter in use. The [WID] button selects a wider filter, the [NAR] button selects a narrower filter.
   • Usable IF filters vary according to receive mode.

4 SCAN STOP BUTTON [STOP] (p. 26)
   Push to cancel scan operation.

5 PROGRAMMED SCAN BUTTON [PROG] (p. 27)
   Push to start/stop programmed scan.
   • “PROG” flashes while scanning.

6 SPAN +/- BUTTONS [SPAN+] /[SPAN−] (p. 34)
   Push to select one of four levels for the band scope frequency span.

7 AUTO MEMORY WRITE SCAN BUTTON [AUTO] (p. 29)
   Push to start/stop auto memory write scan.
   • “AUTO” flashes while scanning.
20 SWEEP START/PAUSE BUTTON [▶/II] (p. 34)
Push to start/pause the band scope (sweep) function which is used to observe signal conditions around the receive frequency.

NOTE: While using the band scope function, audio is NOT output. To monitor the frequency, push [▶/II] to pause the function, or push [■] to cancel the function.

21 MEMORY SCAN BUTTON [MEMO] (p. 30)
Push to start/stop any of the memory scans.
• “MEMO” flashes while scanning.

22 SWEEP STOP BUTTON [■] (p. 34)
Push to stop a band scope (sweep) function.

23 SET BUTTON [SET]
Push to show the setting screen used to adjust settings for scan functions, the band scope function and the automatic mode function.
2 PANEL DESCRIPTION

■ Function display

1 MEMORY BANK INDICATOR (p. 23)
   Indicates the memory bank number (and its name if it has one) being received.

2 MEMORY CHANNEL INDICATOR (p. 23)
   Indicates the memory channel number (and its name if it has one) being received.
   • The name darkens when the receive frequency changes from the stored one.

3 FREQUENCY INDICATION (p. 17)
   Indicates the receive frequency and data as it is being input such as memory channel numbers, etc.

4 S (SIGNAL) METER (pgs. 16, 20)
   Indicates the receive signal strength. Also indicates the S-meter squelch receive level set via the [SQUELCH] control.

5 BAND SCOPE PAUSE INDICATOR [PAUSE] (p. 34)
   Appears when pausing the band scope.

6 BUSY INDICATOR [BUSY]
   Appears when receiving a signal or when signal noise opens the squelch.

7 RECEIVE MODE INDICATORS (p. 18)
   Indicate the current receive mode.
   • “WFM” lights in red when receiving a stereo broadcast program.

8 TUNING STEP INDICATOR (p. 18)
   This is the frequency increment used when selecting a frequency using the tuning dial and when searching for signals using a scan function.

9 IF FILTER INDICATOR (p. 20)
   Indicates the selected IF filter and signal passband width.

10 ATTENUATOR INDICATOR [ATT] (p. 21)
    Appears when the attenuator function is on.
11 AUTOMATIC NOISE LIMITER INDICATOR [ANL] (p. 21)
Appears when the automatic noise limiter is on.

12 TONE SQUELCH INDICATOR [T-SQL] (p. 36)
Appears when the tone squelch is on.

13 AUTOMATIC MODE INDICATOR [AUT-M] (p. 19)
Appears when the automatic mode function is on.

MAXIMUM FREQUENCY SPAN INDICATORS (p. 34)
➥ Indicate the upper and lower observable frequency limits around a receive frequency.
➥ In the diagram, the upper and lower limits are +100 kHz and −100 kHz.

15 FREQUENCY SPAN INDICATION (p. 34)
Indicates the frequency span selected with the [SPAN−] or [SPAN+] button.

16 CENTER FREQUENCY INDICATOR (p. 34)
Indicates the center frequency of the frequency span; this is for the currently received frequency.

17 SWEEP STEP INDICATOR (p. 34)
Indicates band scope sweep step.

18 LIMIT INDICATOR (p. 35)
➥ Indicates when the tuning step is greater than the automatic sweep step setting.
➥ In the diagram, the tuning step is greater than the automatic sweep step setting and the tuning step (TS) and the sweep step width are not the same.
2 PANEL DESCRIPTION

Simple function receiver screen

1 POWER BUTTON [PWR]
Toggles the receiver power ON and OFF.

2 AUTOMATIC MODE INDICATOR [AUT-M] (p. 19)
Appears when the automatic mode function is on.

3 RECEIVE MODE INDICATOR (p. 18)
Indicates the current receive mode.
• “WFM” lights in red when receiving a stereo broadcast program.

4 S (SIGNAL) METER (pgs. 16, 20)
Indicates the receive signal strength. Also indicates the S-meter squelch receive level set via the [SQL Δ]/[SQL ▼] buttons.

5 FREQUENCY INDICATION (p. 17)
Indicates the receive frequency.
• Double-click to display/hide the information display.
• Right-click* to bring up the shortcut menu.

• Shortcut menu

6 MEMORY CHANNEL NAME INDICATOR
Indicates the memory channel name (if it has one).
• The name darkens when the receive frequency changes from the stored one.
• Double-click to display/hide the information display.
• Right-click* to bring up the shortcut menu.
7 MEMORY BANK BUTTON [BANK] (p. 23)
Click to indicate the memory bank menu to select the memory bank number.

Select memory channels between 1 to 5 and indicate the selected memory channel number.
* The selected memory channel number lights red.
* Memory channels 6 – 50 cannot be selected with these buttons. Use the memory list screen to select these memory channels.

9 MENU BUTTON [MENU]
Click to indicate the simple receiver menu to display/hide the sub menu screen such as memory list screen.
* The information display automatically appears when the function controller screen is selected.

- Menu screen

10 VOLUME BUTTONS [△]/[▽] (p. 16)
Adjust the audio output.

11 VOLUME INDICATOR (p. 16)
Indicates the audio output level.

12 BUSY INDICATOR [BUSY]
Appears when receiving a signal or when signal noise opens the squelch.

13 ATTENUATOR INDICATOR [ATT] (p. 21)
Appears when the attenuator function is on.

14 AUTOMATIC NOISE LIMITER INDICATOR [ANL] (p. 21)
Appears when the automatic noise limiter is on.

15 MEMORY BANK INDICATOR (p. 23)
Indicates the memory bank number.

16 MEMORY BANK NAME INDICATOR (p. 23)
Indicates the memory bank name (if it has one).

17 IF FILTER INDICATOR (p. 20)
Indicates the selected IF filter and signal passband width.

18 TUNING STEP INDICATOR (p. 18)
Indicates the frequency increment used when selecting a frequency using the tuning dial and when searching for signals using a scan function.

19 TONE SQUELCH INDICATOR (p. 36)
Indicates the selected tone squelch frequency when the tone squelch is on.

* When the mouse property is set for right-handed.
# Function controller screen

1. **RECEIVE MODE BUTTONS [AM], [FM], [WFM]** (p. 18)
   Select a receive mode.

2. **AUTOMATIC RECEIVE MODE BUTTON [AUT-M]** (p. 19)
   Selects an automatic receive mode. This mode selects a previously programmed receive mode automatically depending on the receive frequency.

3. **TONE SQUELCH BUTTON [TSQL]** (p. 36)
   Push to show or hide the [TONE SQUELCH] dialog box for setting tone squelch frequencies.

4. **SQUELCH UP/DOWN BUTTONS [SQL ▲]/[SQL ▼]** (p. 20)
   Adjust the squelch threshold level. The squelch removes noise output from the speaker (closed condition) when no signal is received.

5. **IF FILTER BUTTONS [NAR]/[WID]** (p. 20)
   Push to change the IF filter in use. The [WID] button selects a wider filter, the [NAR] button selects a narrower filter.
   - Usable IF filters vary according to receive mode.

6. **ATTENUATOR BUTTON [ATT]** (p. 21)
   Push to turn the 20 dB attenuator on and off.

7. **AUTOMATIC NOISE LIMITER BUTTON [ANL]** (p. 21)
   Push to turn the automatic noise limiter for receiving AM signals on and off.

8. **FREQUENCY UP/DOWN BUTTONS [FREQ ▲]/[FREQ ▼]** (p. 17)
   Push to set the receive frequency with the selected tuning step.

9. **TUNING STEP UP/DOWN BUTTONS [TS ▲]/[TS ▼]** (p. 18)
   Push to select the tuning steps.
Simple function receiver sub screens

The simple function receiver screen has an information display and 5 sub screens for saving desktop space and performing various operation. The following sub screens are available.

- Information display
  Double clicking the simple receiver also toggles the information display on/off.

- Memory list screen

- Function controller screen

- Scan controller screen

- Band scoop screen

- Setting screen
BASIC OPERATION

Receiving

Make sure the hardware installation is finished. (p. 1)

❖ Using the multi-function receiver screen

1. Click [POWER] to turn power ON.
2. Click the [VOLUME] control with the sub mouse button to increase the audio level; click the [VOLUME] control with the main mouse button to decrease the audio level.
   • When clicking and holding the control, the audio level scrolls up or down.
3. Set an operating frequency and mode. (pgs. 17, 18)
4. Click the [SQUELCH] control with the sub mouse button to increase the squelch level (tight squelch); click the [SQUELCH] control with the main mouse button to decrease the squelch level (loose squelch).
   • When clicking and holding the control, the squelch level scrolls up or down.
5. When a signal is received:
   ➤ Squelch opens and audio is emitted from the speaker.
   ➤ The S-meter shows the relative signal strength.

❖ Using the simple function receiver screen

1. Click [PWR] to turn power ON.
2. Click [MENU] and select the ‘Function Controller’ when it is not displayed.
3. Click [VOL △] or [VOL □] to set the desired audio level.
   • When clicking and holding either button, the volume level scrolls up or down.
   • Pushing the PC’s [↑] or [↓] key also sets the audio level.
4. Set an operating frequency and mode. (pgs. 17, 18)
5. Click [SQL △] or [SQL □] to set the desired squelch level.
   • When clicking and holding either button, the squelch level scrolls up or down.
6. When a signal is received:
   ➤ Squelch opens and audio is emitted from the speaker.
   ➤ The S-meter shows the relative signal strength.
Setting a frequency

Depending on the situation, the receive frequency can be set using the following methods. Frequencies can be set from 0.01000 to 1300.00000 MHz.

Using the tuning dial

- Click the tuning dial with the sub mouse button to increase the frequency; click the tuning dial with the main mouse button to decrease the frequency.
  - The frequency changes according to the preset tuning steps. See the next page for selecting the tuning step.
  - When clicking and holding either button the frequency scrolls up or down.

Using the simple function receiver screen

1. Click [MENU] and select the ‘Function Controller’ when it is not displayed.
2. Click [FREQ Δ] or [FREQ ‹] on the function controller to set the frequency according to the selected tuning step.
   - The frequency changes according to the selected tuning steps. See the next page for selecting the tuning step.
   - When clicking and holding either button the frequency scrolls up or down.

Using the keypad

- Click the desired numeral buttons, then click [ENT] to set the frequency.
  - When making a mistake while inputting a frequency, click [CE] to clear the input and return to the previous frequency.
  - When you want to change the 100 kHz digit and below, click [•] first, then the numeral buttons and then [ENT].
  - When you want to set the 100 kHz digit and below to 0, input the MHz digits and then click [ENT].
  - When inputting a frequency outside of the allowed receive frequency range, the previously selected frequency is automatically selected after clicking [ENT].

Using the PC keyboard

- Push the desired numeral keys, then push [Enter] to set the frequency.
  - When inputting from the keyboard, click anywhere in the receiver screen first, then begin inputting from the keyboard.
  - When making a mistake while inputting a frequency, push [Esc] to clear the input and return to the previous frequency.
  - When you want to change the 100 kHz digit and below, push [•] first, then the numeral keys and then [Enter].
  - When you want to set the 100 kHz digit and below to 0, input the MHz digits and then push [Enter].
  - Push [↔] or [↕] to set the frequency according to the selected tuning step.
  - When inputting a frequency outside of the allowed receive frequency range, the previously selected frequency is automatically selected after clicking [Enter].
3 BASIC OPERATION

■ Setting a tuning step

When using the tuning dial or [FREQ Δ]/[FREQ ∨] buttons to change the frequency, or when a scan function is activated, the frequency changes in increments determined by the set tuning step. This can be changed if desired.

The following tuning step are available.
- 1 kHz
- 5 kHz
- 6.25 kHz
- 9 kHz
- 10 kHz
- 12.5 kHz
- 15 kHz
- 20 kHz
- 25 kHz
- 30 kHz
- 50 kHz
- 100 kHz
- 500 kHz
- 1 MHz
- 10 MHz

◆ Using the multi-function receiver screen

- Click [TS Δ] or [TS ∨] to set the desired tuning step.
  - The selected tuning step is displayed in the function display.

◆ Using the simple function receiver screen

1. Click [MENU] and select the ‘Function Controller’ when it is not displayed.
2. Click [TS Δ] or [TS ∨] on the function controller screen to select the desired tuning step.
  - The selected tuning step is displayed in the information display if the information display is in use.

■ Receive mode selection

Receive modes are determined by the physical properties of the radio signals. The receiver has 3 receive modes: FM, AM and WFM modes.

Typically, AM mode is used for the AM broadcast stations (0.495–1.620 MHz) and air band (118–135.995 MHz), and WFM is used for FM broadcast stations (76–107.9 MHz).

When using the automatic mode function, a receive mode, tuning step and filter selection are automatically selected after inputting a frequency.

◆ Using the multi-function receiver screen

- Click [FM], [WFM], [AM] or [AUT-M] to select the desired receive mode.

◆ Using the simple function receiver screen

1. Click [MENU] and select the ‘Function Controller’ when it is not displayed.
2. Click [AM], [FM], [WFM] or [AUT-M] to select the desired receive mode.
**Automatic mode selection**

An automatic mode function is available to automatically set the receive mode, IF filter passband width and tuning step after inputting a frequency.

Each click of the [AUT-M] button toggles the automatic mode function on and off.

- For the simple function receiver screen, the [AUT-M] button is on the function controller screen.

**Setting the automatic mode function**

The default setting for the automatic mode function can be added to, changed or deleted. Up to 20 ranges can be memorized into the automatic mode function settings.

1. For the multi-function receiver screen, click the [SET] button to call up the setting screen.
   For the simple function receiver screen, click the [MENU] button and select the ‘Function Setting (SET)’ to call up the setting screen.

2. Click the [Auto Mode] tab to display the automatic mode list.

3. Click a cell in the [Freq Low] column and the desired line.

4. Input the lower frequency of the frequency range from the keyboard, then push [Enter].
   - When nothing is input into the [Freq Low] or [Freq High] column, settings for other columns cannot be made.
   - When inputting a new frequency, other data automatically appears in the other column.
   - To delete a frequency range setting, enter [0] or [Space] into the [Freq Low] column from the keyboard.

5. Input the higher frequency of the frequency range into the [Freq High] column, push the [Enter] key.

6. Set other data such as mode, tuning step, etc., if desired.
   - Double-click the desired cell, select the desired item and double-click the selection.

7. Click the close ([X]) button to close the setting screen.
3 BASIC OPERATION

■ Setting squelch level

The squelch function sets a minimum receive signal level below which no audio is emitted from the speaker. This conveniently prevents noise and static from being emitted when receiving weak signals or no signals at all.

Further setting of squelch removes weak signals. The remove level is displayed on the S-meter (S-meter squelch). The squelch does not open if a signal below the set S-meter level is received.

○ Using the multi-function receiver screen
  ➤ Click the [SQUELCH] control with the sub mouse button to increase the squelch level (tight squelch); click the [SQUELCH] control with the main mouse button to decrease the squelch level (loose squelch).
  • The S-meter squelch level is displayed in the function display.

○ Using the simple function receiver screen
  ① Click [MENU] and select the ‘Function controller’ when it is not displayed.
  ② Click [SQL△] or [SQL▽] on the function controller to select the desired squelch level.
  • The S-meter squelch level is displayed under the frequency indication.

■ IF filter selection

Increasing or decreasing the width of incoming signals can help eliminate interference. Available filters vary according to the receive mode. See the table below.

<table>
<thead>
<tr>
<th>IF filter</th>
<th>6 kHz</th>
<th>15 kHz</th>
<th>50 kHz</th>
<th>230 kHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>FM</td>
<td>○</td>
<td>●</td>
<td>○</td>
<td>–</td>
</tr>
<tr>
<td>WFM</td>
<td>–</td>
<td>–</td>
<td>○</td>
<td>●</td>
</tr>
<tr>
<td>AM</td>
<td>●</td>
<td>○</td>
<td>○</td>
<td>–</td>
</tr>
</tbody>
</table>

●: Factory setting; ○: Selectable; –: Not selectable

○ Using the multi-function receiver screen
  ➤ Click the [WID] or [NAR] buttons to toggle between filter widths.

○ Using the simple function receiver screen
  ① Click [MENU] and select the ‘Function controller’ when it is not displayed.
  ② Click [WID] or [NAR] on the function controller to select the filter width.
Attenuator function

Strong signals (such as from broadcast stations, pocket beepers, nearby amateur radio stations, etc.) can cause distortion of receive signals. The attenuator function can reduce signal strength of interfering signals by approx. 20 dB.

Using the multi-function receiver screen

Click [ATT] to toggle the attenuator function ON and OFF.
• “ATT” appears in the function display.

Using the simple function receiver screen

1. Click [ATT] on the function controller to toggle the attenuator function ON and OFF.
   • “ATT” appears in the information display if the information display is in use.

Automatic noise limiter

The automatic noise limiter removes noise components from an AM signal.

Using the multi-function receiver screen

Click [ANL] to toggle the automatic noise limiter ON and OFF.
• “ANL” appears in the function display.

Using the simple function receiver screen

1. Click [MENU] and select the ‘Function controller’ when it is not displayed.
2. Click [ANL] on the function controller to toggle the automatic noise limiter ON and OFF.
   • “ANL” appears in the information display if the information display is in use.
MEMORY CHANNELS

General
The receiver has 1000 memory channels in 20 banks for storage of often-used frequencies.

Memory channel contents
The following information can be programmed into memory channels:
- Memory channel name
- Operating frequency (p. 17)
- Receive mode (p. 18)
- IF filter selection (p. 20)
- Attenuator ON/OFF (p. 21)
- Tuning step (p. 18)
- Select memory scan setting (p. 31)
- Memory skip scan setting (p. 31)
- Tone squelch ON/OFF and its frequency (p. 36)
- Memory channel comment

Saving memory channels
The memory channels can be stored as a PC file.

Using the multi-function receiver screen
- Select [Save] or [Save As] on the [File] menu to back up memory channel data.
- Select [Open] on the [File] menu to open memory channel data.
- Select [New] on the [File] menu to make a new file for memory channel data.

Using the simple function receiver screen
- Select [Save] or [Save As] in the [File] menu on the shortcut menu to back up memory channel data.
- Select [Open] in the [File] menu on the shortcut menu to open memory channel data.
- Select [New] in the [File] menu on the shortcut menu to make a new file for memory channel data.
**Selecting a memory channel**

Diamond **Using the up/down button on the multi-function receiver screen**

1. Click the [BANK ∧] or [BANK ∨] button to select a memory bank.
2. Click the [CH ∧] or [CH ∨] button to select a memory channel.

Diamond **Using the [Mch] button on the multi-function receiver screen**

- Click the desired numeral buttons (1 to 50), then click [Mch] to set memory channel.
  - When making a mistake while inputting a memory channel, click [CE] to clear the input and return to the previous frequency.

Diamond **Using the simple function receiver screen**

1. Click the [BANK] button and select a desired memory bank.
2. Click a numeral button, [1] – [5], to select memory channels 1 – 5.
  - Use the memory list screen to select memory channels 6 to 50.

Diamond **Using the memory list screen**

1. Call up the memory list screen if it is not displayed.
   - For the multi-function receiver screen, click the memory list screen button or select 'Memory List' from the [View] menu.
   - For the simple function receiver screen, click the [MENU] button and select the 'Memory List.'
2. Click [BANK ∧]/[BANK ∨] or select a bank name with [▼] to select a memory bank.
3. Click the memory channel number in the [CH] column to set the desired memory contents.
   - Click the data area you want to call up, then click [Rx Entry] to call up the data.

Select memory channel

Select memory bank
Memory channel programming

Each memory bank (1 to 20) can hold up to 50 channels and can store the information listed below.
- Bank name, memory name, frequency, mode, filter, attenuator, tuning step, select memory scan, skip channel, tone squelch and remark.

Using the multi-function receiver screen
1. Click the [BANK ∧] or [BANK ∨] button to select a memory bank to be programmed.
2. Click the [CH ∧] or [CH ∨] button to select a memory channel to be programmed.
3. Set a frequency and mode, etc. that you want to memorize.
4. Click the [MW] button to program the displayed frequency into the memory channel.
   - "NONAME" appears in the memory channel indicator.

Using the memory list screen
1. Call up the memory list screen if it is not displayed.
   - For the multi-function receiver screen, click the memory list screen button or select ‘Memory List’ from the [View] menu.
   - For the simple function receiver screen, click the [MENU] button and select the ‘Memory List’.
2. Click [BANK ∧]/[BANK ∨] or select a bank name with [▼] to select a memory bank.
3. Click a cell in the [Frequency] column and the desired memory channel line.
4. Input the receive frequency from the keyboard, then push [Enter].
   - Input frequency first in order for other data to be input.
5. Set other data such as mode, tuning step, etc., if desired.
   - Double-click the desired cell, select the desired item and double-click the selection.

Clearing a memory channel

Using the multi-function receiver screen
1. Select a desired memory channel to be cleared with [BANK ∧]/[BANK ∨] and [CH ∧]/[CH ∨].
2. Click the [MCL] button to clear the memory channel contents.
**EDITING THE MEMORY LIST**

**Editing a bank name**

Bank names and memory names can be set or changed for the screen being used.

1. Call up the memory list screen if it is not displayed.
   - For the multi-function receiver screen, click the memory list screen button or select ‘Memory List’ from the [View] menu.
   - For the simple function receiver screen, click the [MENU] button and select the ‘Memory List.’
2. Click [BANK #] or select a bank name with [ ]
3. To select a memory bank.
4. Click the memory bank name indicator or a memory name cell on the memory list screen.
   - The memory bank name or memory name is highlighted.

   - Input the name from the keyboard.
     - Push [Enter] first to modify the previously input name.
   - Push the [Enter] key to input the name.

**Inserting and deleting channels**

New blank channels can be inserted into the channel list and channels no longer needed can be deleted from the channel list.

1. Call up the memory list screen if it is not displayed.
   - For the multi-function receiver screen, click the memory list screen button or select ‘Memory List’ from the [View] menu.
   - For the simple function receiver screen, click the [MENU] button and select the ‘Memory List.’
2. Click [BANK #] or select a bank name with [ ]
3. To select a memory bank.
4. Click the position where you want to insert/delete a channel.
5. Click [Insert CH] or [Delete CH] to insert or delete the channel at the selected position.
   - When memory channel 50 is not a blank channel, a new blank channel can not be inserted. Delete a channel or use another memory bank in this case.
5 SCAN OPERATION

Scan types

PROGRAMMED SCAN
(p. 27)
Repeatedly scans between two user-programmed frequencies. Used for checking for frequencies within a specified range such as repeater output frequencies, etc.

SELECT MEMORY SCAN
(p. 31)
Repeatedly scans only select memory channels within a memory bank. This function can be turned ON/OFF in [Memory SCAN] tab. Select channels can be set in the memory list screen.

MODE SELECT MEMORY SCAN
(p. 31)
Repeatedly scans only selected mode channels within a memory bank. This function can be set in [Memory SCAN] tab of the setting screen.

MEMORY SCAN
(p. 30)
Repeatedly scans memory channels within a memory bank (1–20).

MEMORY SKIP SCAN
(p. 31)
Skips unwanted memory channels that inconveniently stop scanning. This function can be turned ON/OFF in [Memory SCAN] tab. Skip channels can be set in the memory list screen.

AUTO MEMORY WRITE SCAN
(p. 29)
The frequencies that the programmed scan stops are automatically programmed into a selected memory bank.

Up to 20 programmed scan ranges, memory scan, memory select scan, memory skip scan, mode select memory scan and auto memory write scan provide scanning versatility.
Programmed scan

Programmed scan automatically searches for signals within a specified frequency range.

For programmed scan, scan edges must be programmed in advance. See the next section for details.

Using the multi-function receiver screen

1. Make sure the squelch is set to the threshold point. (closed condition)
2. Click the [SET] button to call up the setting screen if it is not displayed.
3. Click the [Program SCAN] tab to show the program list.
4. Select a programmed scan range to be scanned with the mouse, then click the close ([×]) button.
5. Click the [PROG] button to start programmed scan. “PROG” flashes while scanning.
6. To cancel the scan, click [STOP] or [PROG].
   • When the frequency is changed after cancelling a scan and a new scan is activated, scan starts from the starting frequency of the specified frequency range. When the frequency is not changed, scan starts from the previously stopped frequency.

Using the simple function receiver screen

1. Make sure the squelch is set to the threshold point. (closed condition)
2. Call up the setting screen if it is not displayed.
   • Click the [MENU] button and select the ‘Function Setting (SET).’
   • When the scan controller screen is in use, click the [SET] button on the screen.
3. Click the [Program SCAN] tab to show the program list.
4. Select a programmed scan range to be scanned with the mouse, then click the close ([×]) button.
5. Call up the scan controller screen if it is not displayed.
   • Click the [MENU] button and select the ‘Scan Controller.’
6. Click the [PROG] button in the scan controller screen to start programmed scan.
   • “Program SCAN” flashes in the scan controller screen while scanning.
7. To cancel the scan, click [STOP] or [PROG].
   • When the frequency is changed after cancelling a scan and a new scan is activated, scan starts from the starting frequency of the specified frequency range. When the frequency is not changed, scan starts from the previously stopped frequency.
5 SCAN OPERATION

• Setting scan edges

Settings such as frequency range, receive mode, tuning step, etc. must be set in advance. Up to 20 settings can be programmed.

① Call up the setting screen if it is not displayed.
   • For the multi-function receiver screen, click the [SET] button.
   • For the simple function receiver screen, click the [MENU] button and select the ‘Function Setting (SET).’ When the scan controller screen is in use, click the [SET] button on the screen.

② Click the [Program SCAN] tab to show the program list.

③ Click a start frequency cell in the [START] column to select the data input condition.
   • When a cell is clicked, the scan edges of the line are automatically set as scan edges.

④ Input the start frequency into the selected cell from the keyboard, then push [Enter] (data appears automatically in other cells when new range is entered.).
   • Data must be set in this cell or the [END] cell before data can be set in other cells.
   • To erase the data, push the [Delete] key after selecting a [START] or [END] cell.

⑤ Set data into other cells as desired, then click the close ([X]) button to close the program list.
Auto memory write scan does the same as the programmed scan and then writes paused signal frequencies into memory channels of a specified memory bank. Scan edges must be programmed in advance. (p. 28)

Using the multi-function receiver screen
1. Make sure the squelch is set to the threshold point. (closed condition)
2. Click the [SET] button to call up the setting screen if it is not displayed.
3. Click the [Program SCAN] tab to show the program list.
4. Select the programmed scan edges to be scanned with the mouse, then click the [Auto MW SCAN] tab.
5. Select a memory bank to be written.
   - To clear the selected memory bank contents, click [All Clear].
6. Click the [AUTO] button to start auto memory write scan.
   - “AUTO” flashes while scanning.
7. To cancel the scan, click [STOP] or [AUTO].

Using the simple function receiver screen
1. Make sure the squelch is set to the threshold point. (closed condition)
2. Call up the setting screen if it is not displayed.
   - Click the [MENU] button and select the ‘Function Setting (SET).’
   - When the scan controller screen is in use, click the [SET] button on the screen.
3. Click the [Program SCAN] tab to show the program list.
4. Select the programmed scan edges to be scanned with the mouse, then click the [Auto MW SCAN] tab.
5. Select a memory bank to be written.
   - To clear the selected memory bank contents, click [All Clear].
6. Call up the scan controller screen if it is not displayed.
   - Click the [MENU] button and select the ‘Scan Controller.’
7. Click the [AUTO] button to start auto memory write scan.
   - “Auto MW SCAN” flashes while scanning.
8. To cancel the scan, click [STOP] or [AUTO].
5 SCAN OPERATION

Memory scan

This function searches all memory channels in a selected memory bank.

◊ Using the multi-function receiver screen

1. Make sure the squelch is set to the threshold point. (closed condition)
2. Click the [BANK ∧] or [BANK ∨] button to select the desired memory bank.
   • When using the memory list screen, click [BANK ∧]/[BANK ∨] or select a bank name with [▼] to select a memory bank.
3. Click the [SET] button to call up the setting screen if it is not displayed.
4. Click the [Memory SCAN] tab.
5. Make sure the check boxes are not checked (✓) then click the close ([X]) button.

Not checked for the memory scan

6. Click the [MEMO] button to start memory scan.
   • “MEMO” flashes while scanning.
7. To cancel the scan, click [STOP] or [MEMO].

◊ Using the multi-function receiver screen

1. Make sure the squelch is set to the threshold point. (closed condition)
2. Click the [BANK] button and select the desired memory bank.
   • When using the memory list screen, click [BANK ∧]/[BANK ∨] or select a bank name with [▼] to select a memory bank.
3. Call up the setting screen if it is not displayed.
   • Click the [MENU] button and select the ‘Function Setting (SET).’
   • When the scan controller screen is in use, click the [SET] button on the screen.
4. Click the [Memory SCAN] tab.
5. Make sure the check boxes are not checked (✓) then click the close ([X]) button.
6. Click the [MEMO] button in the scan controller screen to start memory scan.
   • “Memory SCAN” flashes while scanning.
7. To cancel the scan, click [STOP] or [MEMO].
Versatile memory scan

Using the [Memory SCAN] tab in the setting screen you can set conditions specific only to memory channels during memory scan.

1. Call up the setting screen if it is not displayed.
   • For the multi-function receiver screen, click the [SET] button.
   • For the simple function receiver screen, click the [MENU] button and select the ‘Function Setting (SET).’ When the scan controller screen is in use, click the [SET] button on the screen.
2. Click the [Memory SCAN] tab.
3. Make sure the desired check boxes are checked (√).

- When selecting the [SEL] box (select memory scan), only memory channels specified as SEL (select) are scanned.
- When selecting the [SKIP] box (memory skip scan), memory channels specified as SKIP channels are not scanned.
- When selecting the [MODE SEL] box (mode select memory scan), only memory channels programmed with the specified receive mode (in the [Select Mode] check box) are scanned.

4. Click the close ([×]) button.
5. Start the desired memory scan.
   • For the multi-function receiver screen, click the [MEMO] button.
   • For the simple function receiver screen, click the [MEMO] button in the scan controller screen.
6. To cancel the scan, click [STOP] or [MEMO].

- All settings can be used simultaneously.
- SEL, SKIP and receive mode are set in the memory list screen.
- At least 2 memory channels must be programmed with the desired condition for scan to proceed.
5 SCAN OPERATION

Scan resume condition

When receiving a signal, scan automatically pauses on that signal. The scan resume condition sets the time that the scan pauses before resuming or whether scan stops instead of pausing.

① Call up the setting screen if it is not displayed.
   • For the multi-function receiver screen, click the [SET] button.
   • For the simple function receiver screen, click the [MENU] button and select the ‘Function Setting (SET).’ When the scan controller screen is in use, click the [SET] button on the screen.

② Click the [SCAN Delay] tab, then click to select a resume condition from [DELAY Timing].

(a) ‘Pause until Signal disappears’
Scan pauses when receiving a signal and remains paused until the signal disappears.

(b) ‘Delay Volume’
When setting a delay time using the [DELAY] control (multi-function receiver screen) or [DELAY] scroll bar (scan controller screen), scan pauses when receiving a signal and then resumes after the specified delay.

(c) ‘SCAN Stop’
When a signal is received during scan, scan stops and does not resume.

③ Click to select a restart delay time from [Restart Delay].
This setting is valid when selecting (a) or (b) above.

(a) 0 Sec.
Scan resumes immediately after the signal disappears.

(b) 1 Sec.
Scan resumes 1 sec. after the signal disappears.

(c) 2 Sec.
Scan resumes 2 sec. after the signal disappears.

④ Click the close ([X]) button to close the setting screen.
Scan speed setting

The searching speed of frequencies or memory channels is variable.

Using the multi-function receiver screen

- Click the [SPEED] control with the sub mouse button to increase the scan speed; click the [SPEED] control with the main mouse button to decrease the scan speed.
  - When clicking and holding the control, the scan speed scrolls up or down.

Using the simple function receiver screen

1. Call up the scan controller screen if it is not displayed.
   - Click the [MENU] button and select the ‘Scan Controller.’
2. Drag the [SPEED] scroll bar upward to increase the scan speed and downward to decrease the scan speed.
Operation

The band scope function allows you to visually check a specified frequency range.

Receive audio is muted while monitoring the band scope.

Push [▶/II] to pause sweeping and receive the audio.

Using the multi-function receiver screen

1. Click the sweep start/pause button ([▶/II]) to begin a sweep; signal conditions appear starting from the center of the range.
   - Conditions over the entire set frequency span can be observed around the center frequency of the currently received frequency.
2. Click the [SPAN+] or [SPAN−] button to select the sweep width through SPAN1 (±100 kHz) to SPAN4 (±2 MHz).
3. Click the [TS △] or [TS ▽] button to select the sweep tuning step.
   - “LIMIT” appears when a tuning step greater than the sweep step range is selected.
4. Click the waveform to select the frequency of the signal.
   - Click the [▶/II] button to pause a sweep and monitor the frequency. Repeat to resume the sweep.
   - While pausing the band scope, you can also select the frequency by clicking the waveform. The current receive frequency is marked by a dotted line and the previous receive frequency is displayed at center.
5. Click the sweep stop button ([■]) to cancel a sweep.

Using the simple function receiver screen

1. Call up the band scope screen if it is not displayed.
   - Click the [MENU] button and select the ‘Band Scope.’
2. Click the sweep start/pause button ([▶/II]) to begin a sweep; signal conditions appear starting from the center of the range.
   - Conditions over the entire set frequency span can be observed around the center frequency of the currently received frequency.
3. Click the [▲] or [▼] button to select the sweep width through SPAN1 (±100 kHz) to SPAN4 (±2 MHz).
   - Choose [SPAN1] when band conditions are crowded (many signals are present); choose [SPAN4] when few signals are present.
4. Click the [TS △] or [TS ▽] button on the function controller screen to select the sweep tuning step.
   - Click [MENU] and select the ‘Function controller’ when it is not displayed.
   - “LIMIT” appears when a tuning step greater than the sweep step range is selected.

Click to start or pause sweeping.

Click to select sweep width.
5. Click the waveform to select the frequency of the signal.
   • Click the [▶/II] button to pause a sweep and monitor the frequency. Repeat to resume the sweep.
   • While pausing the band scope, you can also select the frequency by clicking the waveform. The current receive frequency is marked by a dotted line and the previous receive frequency is displayed at center.
6. Click the close ([×]) button to stop sweeping and close the band scope screen.

### Changing the automatic sweep step limit

The frequency steps used while sweeping are automatically set according to the tuning step. However, these steps can be defined using the [BAND SCOPE] tab on the setting screen.

1. Call up the setting screen if it is not displayed.
   • For the multi-function receiver screen, click the [SET] button.
   • For the simple function receiver screen, click the [MENU] button and select the ‘Function Setting (SET).’ When the scan controller screen is in use, click the [SET] button on the screen.
2. Click the [BAND SCOPE] tab.
3. Click a frequency step range from inside the [Automatic Sweep-Step Limit].
   • The sweep step range can be selected from one of 1 kHz to 100 kHz, 1 kHz to 50 kHz or 1 kHz to 25 kHz.

4. Click the close ([×]) button to close the setting screen.

Diamond About the limit indicator
When using the band scope function and the selected tuning step (TS) is outside the automatic sweep step setting, [LIMIT] appears in the band scope display. This indicates that the tuning step (TS) and the sweep step width are not the same.
The tone squelch opens only when receiving a signal containing a matching subaudible tone in FM mode. For example, you can silently wait for calls from group members using the same tone in an amateur band.

**Using the multi-function receiver screen**

1. Click the [FM] button to select FM mode.
2. Click the [T-SQL] button to bring up the [TONE SQUELCH] dialog box.
   - “T-SQL” appears in the function display.
3. Click the [▼] button, then select the desired tone squelch frequency.
   - Fifty-one tone frequencies from 67.0 to 254.1 Hz are available.
4. Click the close ([X]) button to close the [TONE SQUELCH] dialog box.
5. When the received signal includes a matching tone, squelch opens and the signal can be heard.
   - When the received signal’s tone does not match, tone squelch does not open, however, the S-indicator shows signal strength.
6. Click the [T-SQL] button to cancel the tone squelch.
   - “T-SQL” disappears.

**Using the simple function receiver screen**

1. Click [MENU] and select the ‘Function Controller’ when it is not displayed.
2. Click the [FM] button in the function controller screen to select FM mode.
3. Click the [TSQL] button to bring up the [TONE SQUELCH] dialog box.
   - “T-SQL” and tone squelch frequency appear in the information display.
4. Click the [▼] button, then select the desired tone squelch frequency.
   - Fifty-one tone frequencies from 67.0 to 254.1 Hz are available.
5. Click the close ([X]) button to close the [TONE SQUELCH] dialog box.
6. When the received signal includes a matching tone, squelch opens and the signal can be heard.
   - When the received signal’s tone does not match, tone squelch does not open, however, the S-indicator shows signal strength.
7. Click the [TSQL] button to cancel the tone squelch.
   - “T-SQL” and tone squelch frequency disappear.

**Available tone squelch frequencies** (unit: Hz)

<table>
<thead>
<tr>
<th>Frequency</th>
<th>67.0</th>
<th>69.3</th>
<th>71.0</th>
<th>71.9</th>
<th>74.4</th>
<th>77.0</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>79.7</td>
<td>82.5</td>
<td>85.4</td>
<td>88.5</td>
<td>91.5</td>
<td>94.8</td>
</tr>
<tr>
<td></td>
<td>97.4</td>
<td>100.0</td>
<td>103.5</td>
<td>107.2</td>
<td>110.9</td>
<td>114.8</td>
</tr>
<tr>
<td></td>
<td>118.8</td>
<td>123.0</td>
<td>127.3</td>
<td>131.8</td>
<td>136.5</td>
<td>141.3</td>
</tr>
<tr>
<td></td>
<td>146.2</td>
<td>151.4</td>
<td>156.7</td>
<td>159.8</td>
<td>162.2</td>
<td>165.5</td>
</tr>
<tr>
<td></td>
<td>167.9</td>
<td>171.3</td>
<td>173.8</td>
<td>177.3</td>
<td>179.9</td>
<td>183.5</td>
</tr>
<tr>
<td></td>
<td>186.2</td>
<td>189.9</td>
<td>192.8</td>
<td>196.6</td>
<td>199.5</td>
<td>203.5</td>
</tr>
<tr>
<td></td>
<td>206.5</td>
<td>210.7</td>
<td>218.1</td>
<td>225.7</td>
<td>229.1</td>
<td>233.6</td>
</tr>
<tr>
<td></td>
<td>241.8</td>
<td>250.3</td>
<td>254.1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
If your receiver seems to be malfunctioning, please check the following points before sending it to a service center.

<table>
<thead>
<tr>
<th>PROBLEM</th>
<th>POSSIBLE CAUSE</th>
<th>SOLUTION</th>
<th>REF.</th>
</tr>
</thead>
<tbody>
<tr>
<td>No power comes ON.</td>
<td>• The RS-232C cable is not connected correctly.</td>
<td>• Check the RS-232C cable.</td>
<td>p. 1</td>
</tr>
<tr>
<td></td>
<td>• The RS-232C port is not selected correctly.</td>
<td>• Select the RS-232C port correctly.</td>
<td>p. 5</td>
</tr>
<tr>
<td>No sound comes from the speaker.</td>
<td>• Volume level is too low.</td>
<td>• Click the [VOLUME] control with the sub mouse button or click the volume [Δ] button to obtain a suitable level.</td>
<td>p. 16</td>
</tr>
<tr>
<td></td>
<td>• The squelch is closed.</td>
<td>• Click the [SQUELCH] control with the main mouse button or click the [SQL ↓] button to open the squelch.</td>
<td>p. 20</td>
</tr>
<tr>
<td></td>
<td>• Band scope function is in use.</td>
<td>• Pause or cancel the band scope function.</td>
<td>p. 34</td>
</tr>
<tr>
<td></td>
<td>• Different tone is selected with tone squelch.</td>
<td>• Check the tone squelch frequency.</td>
<td>p. 36</td>
</tr>
<tr>
<td>Receive audio is distorted.</td>
<td>• The operating mode is not selected correctly.</td>
<td>• Select a suitable operating mode with [FM], [WFM], [AM] or [AUT-M].</td>
<td>pgs. 18, 19</td>
</tr>
<tr>
<td></td>
<td>• The IF filter is not selected correctly.</td>
<td>• Select a suitable IF filter with [NAR] or [WID].</td>
<td>p. 20</td>
</tr>
<tr>
<td>Sensitivity is low.</td>
<td>• The attenuator is activated.</td>
<td>• Click the [ATT] button to cancel the function.</td>
<td>p. 21</td>
</tr>
</tbody>
</table>
### Specifications

- **Frequency coverage (MHz):**
  - U.S.A. version: 0.01–823.999, 849.001–868.999, 894.001–1300
  - Non-U.S.A. versions: 0.01–1300
  - *Specifications guaranteed 0.5–1300 MHz only.

- **Receive system:**
  - Triple superheterodyne (AM/FM)
  - Double superheterodyne (WFM)

- **Mode:** FM, AM, WFM,

- **Frequency stability:** ± 5 ppm at 1300 MHz
  - (0°C to +50°C; 32°F to +122°F)

- **Frequency resolution:** 1 kHz (minimum)

- **Power supply:** 13.8 V DC ±15 % for receiver requirement
  - unit; or, supplied AC adapter (negative ground)

- **Current drain (at 13.8 V DC):**
  - Standby (software OFF): 0.1 A
  - Receive (squelched): 0.6 A
  - Receive (max. audio): 0.7 A

- **Usable temp. range:** 0°C to +50°C; +32°F to +122°F

- **Intermediate frequencies:**
  - 1st: 266.7 MHz
  - 2nd: 10.7 MHz
  - 3rd: 450 kHz (except WFM)

- **Receive sensitivity (typical):**
  - *When 230 kHz (for WFM), 15 kHz (for FM) and 6 kHz (for AM) passband widths are selected.

<table>
<thead>
<tr>
<th>Frequency (MHz)</th>
<th>AM (10 dB S/N)</th>
<th>FM (12 dB SINAD)</th>
<th>WFM (12 dB SINAD)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5–1.799</td>
<td>2.5 µV</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.8–27.999</td>
<td>1.8 µV</td>
<td></td>
<td></td>
</tr>
<tr>
<td>28–49.999</td>
<td>0.5 µV</td>
<td></td>
<td></td>
</tr>
<tr>
<td>50–699.999</td>
<td>1.0 µV</td>
<td>0.32 µV</td>
<td>0.79 µV</td>
</tr>
<tr>
<td>700–1300</td>
<td>1.3 µV</td>
<td>0.4 µV</td>
<td>1.0 µV</td>
</tr>
</tbody>
</table>

- **Squelch sensitivity (threshold):**

<table>
<thead>
<tr>
<th>Frequency (MHz)</th>
<th>AM (10 dB S/N)</th>
<th>FM (12 dB SINAD)</th>
<th>WFM (12 dB SINAD)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5–1.799</td>
<td>1.8 µV</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.8–27.999</td>
<td>0.89 µV</td>
<td></td>
<td></td>
</tr>
<tr>
<td>28–49.999</td>
<td>0.71 µV</td>
<td>0.63 µV</td>
<td>5.6 µV</td>
</tr>
<tr>
<td>50–699.999</td>
<td>0.71 µV</td>
<td>0.5 µV</td>
<td>5.6 µV</td>
</tr>
<tr>
<td>700–1300</td>
<td>0.89 µV</td>
<td>0.63 µV</td>
<td>10 µV</td>
</tr>
</tbody>
</table>
SPECIFICATIONS AND SUPPLIED ACCESSORIES

• Selectivity (typical):
  FM/AM 6 kHz/–6 dB
  FM/AM 15 kHz/–6 dB
  WFM/FM/AM 50 kHz/–6 dB
  WFM 230 kHz/–6 dB

• Max. audio output: 0.2 W (monaural)
  0.1 W × 2 (stereo)
  (at 10% distortion with an 8 Ω load)

• Antenna connector: BNC (50 Ω)

• RS-232C connector: D-sub 9-pin (female)

• Ext. speaker connector: 3-conductor 3.5 (d) mm (⅛”)/4–8 Ω

• Dimensions (projections not included):
  131(W) × 33.5(H) × 154.5(D) mm
  5⅜(W) × 1⅜(H) × 6⅜(D) in

• Weight: approx. 0.5 kg; 1 lb 2 oz.

All stated specifications are subject to change without notice or obligation.

Supplied accessories

1. Wire antenna ................................................................. 1
2. RS-232C cable (OPC-743) ............................................. 1
3. AC adapter (BC-123A/E or BM-104E)* ...................... 1
4. Software floppy disks ................................................ 1 set

Accessories included with the receiver:

* For versions which do not come with an AC adapter, a DC power cable (OPC-131) and 2 fuses (FGB 2 A) are supplied. An optional AC adapter (BC-123E or BM-104E) is also available.
Count on us!